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NAMNAM: Management & IT Tips, Tricks & Resources is a  weekly Internet 
newsletter for Non-Profit organizations (NPOs), published for the Non-
profit Association of the Midlands, courtesy of the University of Nebraska 
at Omaha Executive MBA Program. It provides a compilation of useful 
Internet sites, free or low cost computer applications, and productivity tips 
for office applications that will be of use to NPO paid and volunteer staff. 

The newsletter has five sections: 

Office Productivity:  Focuses on tips and tricks for users of       
Microsoft Windows, Internet Explorer, Word, and PowerPoint.  

 

CyberSites: Highlights Internet sites of use or interest to website 
developers, technology managers and computer users. 

 

NPO Executive’s Resources:  Offers websites of interest to non-
profit organization, Senior Managers. 

 

NPO Manager Resources:  Offers websites of interest to non-
profit organization functional and program managers. 

 Ruminations:  My chance AND your chance to offer observa-
tions on life, work and whatever. 

“There's a dear little plant that grows in our isle, 'Twas St. Patrick himself sure that set it; And the sun on his 
labor with pleasure did smile, And with dew from his eye often wet it. It thrives through the bog, through the 
brake, and the mireland; And he called it the dear little shamrock of Ireland-- The sweet little shamrock, the 

dear little shamrock, The sweet little, green little, shamrock of Ireland!”   Andrew CherryAndrew Cherry  
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Office ProductivityOffice Productivity  

Word:  
 
How to Work Faster in Microsoft Word – “If you spend a lot of time using Microsoft’s ubiquitous 
word processor, wouldn’t it be great if you could spend less time using it? Web Worker Daily offers 12 
time-savers for Microsoft Word, starting with this one: Paste Your Formats.”   
http://webworkerdaily.com/2008/02/21/12-time-saving-tips-for-microsoft-word/ 
 
Applying Character Formats the Easy Way in Microsoft Word – “You can apply character formats 
before or after you type the text you want to format. To apply a character format to text as you type it, 
follow these steps:” http://tinyurl.com/ypyzug                                              . 
 
Compare and Combine (Word 2007)  – “ It used to be, when you wanted to compare two documents, 
you had to open them both and switch back and forth between them. With the new Compare feature in 
Word 2007, those days are behind you: On the Review tab, in the Compare group, click Compare, and 
then click Compare again. Enter the documents in the dialog box, and click OK.  Continuing with the 
Compare feature, you can merge comments and changes from two documents into one document: On 
the Review tab, in the Compare group, click Compare, and then click Combine. Enter the documents as 
for comparing.” 

 

 

 

Microsoft Office 
applications tips 

and tricks 
designed to help 
make your time 
on the computer  
easier and more 

productive.   

PowerPoint: 
 
Create and manage PowerPoint table data – “Tables are great for communicating and organizing data in a meaningful, effi-
cient way. However, in Microsoft PowerPoint, tables can be a bit troublesome because of space limitations. Too much data on 
one slide can be worse than no data at all. Susan Harkins shows you how to get creative and improvise how you display tables 
in PowerPoint.”  http://blogs.techrepublic.com.com/howdoi/?p=204&tag=nl.e064 
 
Limit your carry-on baggage (PowerPoint 2007) – “ When you embed a font into your presentation, the file size grows by as 
much as the font file (which is usually a lot — some of the new Unicode fonts are monsters). This means you are carrying um-
lauts and italics you don't use. PowerPoint 2007 enables you to embed only the specific characters actually used in the presenta-
tion, baggage you packed yourself. This will cut down on the size by quite a bit.” 
 
PowerPoint: Linking in PowerPoint 2007 - “A tutorial that shows you how to link to websites and add Action Buttons.”  
http://www.bytesizeoffice.co.uk/PowerPoint%202007.%20links%20docx.pdf 
 

Excel: 
View two worksheets in the same workbook side-by-side (Excel 2007) – “ Switching back and forth between worksheets 
can make your eyes spin around in their sockets.  Keep those baby blues steady when you use Excel 2007: On the View tab, in 
the Window group, click New Window.  On the View tab, in the Window group, click View Side by Side . In the Compare 
Side by Side dialog box, click the worksheets that you want to compare.  To scroll both worksheets at the same time, click 
Synchronous Scrolling  in the Window group on the View tab.” 

Fast Data Entry in Excel – “Saving yourself the time and trouble of manually typing info into Excel does more than speed 
you up—it'll improve accuracy, too.   Anytime you can enter data without having to type it yourself, you improve accuracy 
and save yourself effort. There are plenty of opportunities in Excel to enter data in a faster and smarter way than via the key-
board.”  http://www.pcmag.com/article2/0,2704,2224429,00.asp  

“Th' an'am an Dhia, but there it is-- The dawn on the hills of Ireland. God's angels lifting the night's black 
veil From the fair sweet face of my sireland! O Ireland, isn't it grand, you look Like a bride in her rich 

adornin', And with all the pent up love of my heart I bid you the top of the morning.”  
           John LockeJohn Locke 
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CyberSitesCyberSites  

Web Surf & Search: 
Zotero- “A free, easy-to-use Firefox extension to help you collect, manage, and cite your research 
sources. It lives right where you do your work — in the web browser itself.  Automatic capture of 
citation information from web pages  Storage of PDFs, files, images, links, and whole web pages.   
Flexible note taking with autosave.  Fast, as-you-type search through your materials.  Playlist-like 
library organization, including saved searches (smart collections) and tags.   Platform for new forms 
of digital research that can be extended with other web tools and services.   Runs right in your web 
browser.   Formatted citation export (style list to grow rapidly).  Free and open source  Integration 
with Microsoft Word and OpenOffice”  http://www.zotero.org/ 
 
Pinakes—”Conveniently brings together a large range of subject and multi- subject gateways across 
many academic disciplines, including art, law, psychology and business and economics.”                 .                     
http://www.hw.ac.uk/libWWW/irn/pinakes/pinakes.html 

 

 
 

Highlights sites of use 
or interest to website 
developers, computer 

users and 
information 
technology  
managers. 

Website Design: 
 
Make sure that your Web site can be read easily –“ Discover some excellent resources for Web accessibility and usability.”  
http://ga0.org/ct/I71dV-M1qT_N/ 
 
KompoZer – “A complete web authoring system that combines web file management and easy-to-use WYSIWYG web page 
editing.   KompoZer is designed to be extremely easy to use, making it ideal for non-technical computer users who want to create 
an attractive, professional-looking web site without needing to know HTML or web coding.  Free.”   http://www.kompozer.net/ 
 

Technical:  
 
Nonprofit IT Staffing: Budgets, Salaries, Training and Planning – “Staffing the information technology (IT) function is fre-
quently a challenge for nonprofit organizations. Financial resources are typically limited, and hiring managers often feel over-
whelmed and under-educated when it comes to IT. Determining where IT should fit into the organization, how many IT staff 
people are needed, and what those people should be spending their time doing can be difficult decisions.  In order to shed some 
light on these questions, NTEN and the Nonprofit Times teamed up to create the Nonprofit IT Staffing Survey. The results of 
this survey will be presented in three parts.”  http://nten.org/research/nonprofit-it-staffing-budgets-salaries-training-and-planning 
 
10 ways to trim your IT budget – “In this election year, everyone is worried about the economy. Experts disagree about 
whether the United States is headed for a recession, but the housing slump, losses on Wall Street, and the skyrocketing price of 
oil have both individuals and companies looking for ways to tighten their belts and trim their budgets. Nobody likes being told to 
spend less, but the tough reality is that in many organizations, all departments are seeing their budgets cut — and that includes 
IT. The question now is not whether to trim the budget, but how to do it in a way that’s least painful for the company and its em-
ployees. In this article, we’ll take a look at a few ways you may be able to save big bucks by making little (and not-so-little) 
changes.” http://blogs.techrepublic.com.com/10things/?p=315&tag=nl.e056 
 
Thumbalizr—”Capture an image in set sizes (widths, heights).”  http://www.thumbalizr.com  

 
“For dear is the Emerald Isle of the ocean, Whose daughters are fair as the foam of the wave,   

         Whose sons unaccustom'd to rebel commotion, Tho' joyous, are sober--tho' peaceful, are brave.” 
         Horace Smith and James SmithHorace Smith and James Smith 
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“You've got to do your own growing,  

       no matter how tall your grandfather was. “ 
                Irish ProverbIrish Proverb  

NPO Executive’s NPO Executive’s   
ResourcesResources  

 

 

 

 

 
 

Information 
and websites of 

interest to      
non-profit 

organization 
senior 

managers. 
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Nonprofit Management: 
 
Ready to Lead: Next Generation Leaders Speak Out – “In Daring to Lead we learned that three out of four executive direc-
tors surveyed (a sample of about 2000 from eight US metropolitan areas) said they would be likely to leave their jobs within the 
next five years. The Meyer Foundation has now released the obvious successor to that study, looking at who is (and who isn't) 
ready to replace these leaders. Ready to Lead: Next Generation Leaders Speak Out (cover page for 36 page PDF of full report 
and many other documents) presents the result of a survey of over 6000 "next generation" leaders.     The news isn't entirely 
grim, but it's not pretty either. Barriers for these leaders include: the burden of fundraising, demands for overwork, a sense that 
it's not the ideal way to make a difference, and a preference for program work.     The report makes recommendations to current 
leaders, emerging leaders, boards of directors, capacity builders, and funders. My favorites, from across the categories, include: 
(1) Replace dated power structures. (2) Help staff build strong external networks. (3) Find or be a mentor and good role model. 
(4) Pay reasonable salaries and provide benefits. (5) Upgrade training programs to be relevant and fresh, including coaching. (6) 
Engage in and ask about succession planning. (7) Recognize generational differences.”   
http://meyerfoundation.org/newsroom/meyer_publications/ready_to_lead 
 
Social Entrepreneurship Teaching Resources Handbook -  Recently released by  Ashoka's Global Academy for Social En-
trepreneurship, “the handbook is an excellent reference guide.  The plethora of resources includes a mapping of over 250 pro-
fessors who are actively teaching or researching in social entrepreneurship from more than 35 countries, with 29 different com-
petitions, over 800 different articles and 200 cases used in social entrepreneurship courses.”   
http://www.universitynetwork.org/files/Social%20Entrepreneurship%20Handbook%20010508.pdf  

General Management: 
 
Communication for Managers 101 - “Effective communication is the number one skill for executives to 
develop. But this skill is neglected when it comes to employee development.”  http://tinyurl.com/2wn87f 
 
10 Management Lessons – “Once you have hired good people, how do you manage them? Here's a few 
tips from Ryan Allis's book, Zero to One Million.”    http://tinyurl.com/34bebc 
                                                
How to Speak – “In this skillful lecture, Professor Patrick Winston of the Massachusetts Institute of 
Technology offers tips on how to give an effective talk, cleverly illustrating his suggestions by using 
them himself. He emphasizes how to start a lecture, cycling in on the material, using verbal punctuation 
to indicate transitions, describing "near misses" that strengthen the intended concept, and asking ques-
tions. He also talks about using the blackboard, overhead projections, props, and "how to stop."    
http://isites.harvard.edu/fs/html/icb.topic58703/winston1.html 
 
5 Characteristics That Every Leader Needs – “Executive coach / Harvard Business blogger Marshall 
Goldsmith on what leaders of the future need to survive the business world.”  http://tinyurl.com/2ln6s7 
 
Identifying incompetence – “The epidemic of bad management is a global one, but wherever it is found, 
incompetence is marked out by some common traits.   Learn the top ten habits that reveal total incompe-
tence.”  http://www.management-issues.com/default.asp 
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“May all who love the Lord, love you and those who don't love you,  
may the Lord give them a limp so you can see them coming.”  

                    Irish BlessingIrish Blessing  

NPO Manager’s NPO Manager’s   
ResourcesResources  

Marketing & Resource Raising: 
 
Follow the Events Path to Major Gifts – “That special event your organization is holding could pay off 
in more than ticket sales or silent auction proceeds—it could net you some major donors.  Events are a 
common fundraising tactic among nonprofits. Dinners, galas, runs, walks, and auctions are all variations 
of the ever-promising, always-delivering event fundraiser. Events encourage constituents to act in favor 
of the organization and provide a means for nonprofits to cultivate the relationship. But events have much 
more to offer. They can be a mechanism to discover major gift donors. Events often create a donor's first 
impression of an organization. They can be the beginning of a long-term relationship, or they can be the 
end. ... Read more.”  http://www.guidestar.org/news/features/events.jsp 
 
Five Fundraising Mistakes We Make with Our Boards – “Having trouble getting your board members 
to pitch in with fundraising? See if you're committing one or more of these errors.  Too often nonprofit 
board members shy away from fundraising. When the subject comes up, many trustees suddenly become 
invisible or silent. Yet it is our responsibility to set up board members in active, satisfying roles that can 
support the fundraising process. But we frequently make mistakes that hurt, rather than help, our cause. ... 
Read more.”  http://www.guidestar.org/news/features/board_fundraising.jsp 

 
 
 
 

 
 
 
 

 
Information of 
interest to non-

profit 
organization 

functional and 
program 

managers. 

Program Management: 
 
Key Personality Types – “Much like characters in a role-playing game, everyone on a successful team plays a unique part. 
When certain challenges arise, you need to know whose strengths will best match the task. Here are a few key personality types 
to look for.”  http://www.bnet.com/2403-13059_23-185372.html 
 

Personal Productivity: 
 
Critical Thinking Web – “Teaching critical thinking can be difficult.  This website to provide access to over 100 free online 
tutorials on critical thinking, logic, scientific reasoning, and creativity. The homepage includes a brief introduction to critical 
thinking and access to the main modules, which are divided into thematic areas such as values and morality, strategic thinking, 
and basic logic.” http://philosophy.hku.hk/think/  
 
Build a Workgroup Wiki with Google Sites – “There’s a new kid on the Google Apps block. Google Sites enables companies, 
teams, schools, and other organizations to create information-packed Web sites. The first fruit of Google’s 2007 acquisition of 
wiki-builder JotSpot, Sites  lets you ”centralize all types of information — from videos to presentations — and share your site 
with just a few people, your entire organization.”  http://sites.google.com/ 
 
Create Video Tutorials with Free Screencasting Software – “A video tutorial (a.k.a. screencast) can be a great way to teach 
new hires how to use company systems, show prospective customers a killer product demo, and so on. The always-informative 
MakeUseOf lists five free applications (for Windows and Mac) you can use to whip up video tutorials right on your PC.”   
http://www.makeuseof.com/tag/5-free-screencasting-apps-for-creating-video-tutorials/ 
 
Sweet Home 3D – “A free interior design application that helps you place your furniture in a house’s 2D plan, giving you a 3D 
preview.”  http://sweethome3d.sourceforge.net/ 
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“May the road rise to meet you. May the wind always be at your back. May the sun shine warm upon your “May the road rise to meet you. May the wind always be at your back. May the sun shine warm upon your 
face, the rains fall soft upon your fields and, until we meet again, may God hold you in the palm of his hand.” face, the rains fall soft upon your fields and, until we meet again, may God hold you in the palm of his hand.”   

                Irish Blessing Irish Blessing   

RuminationsRuminations  

 

 
 
 
 
  
RuminationsRuminations:  
My chance 
AND your 
chance to 
offer rants, 
raves and 
observations 
on life, work 
and whatever. 
 
Send your 
ruminations to 
cbayer@mail.
unomaha.edu 
for 
publication 
consideration. 
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 Hi All - 
 

No, I’m not Irish by heritage - German on one side 
of the family and Scotch-English on the other.  
However, on St. Patrick’s Day anyone, even me, 
can be Irish! 
 
St. Patrick’s Day is a notably American inspired 
holiday, one worthy of a further look for what it 
says about our country and our values. 
 
In their day, the Irish were the major immigrant 
population in the U.S.  They took the jobs no one 
else wanted and performed admirably in them.  As 
the newcomers, they bore the brunt of the estab-
lished populations’ prejudices and stereotyping.  As 
newcomers, living on the leavings of established 
society, they flourished, and generation by genera-
tion, moved from the fringe to the mainstream of 
the American dream.  On St. Patrick’s Day we 
celebrate not only their Irish heritage, but their 
emergence from being ‘them’ to being of ‘us.’ 
 
The Irish experience is not a particularly unique in 
American history.  The Germans before them, the 
Chinese, the middle-Europeans—each had to face 
the pain and prejudice of new immigrants and ulti-
mately assimilate into the broader American soci-
ety.  Many came without benefit of invitation or 
documentation.  Yet in every case, the immigrant 
population as a whole contributed far more to the 
growth, economic success and cultural diversity of 
their adopted home than they cost it in terms of 
services, financial assistance, education or any 
other outlay one might ascribe to their presence. 
 
With such a historical record of positive return on 
investment, and with the clear record of their indi-
vidual and community contributions to the greater 
good, how is it that today that we obsess over  the 
presence and impact of  Latino immigrants in our 
country?  
 
St. Patrick’s Day provides an opportunity and rea-
son to remember that the USA is a nation of immi-

grants.  Except for the Native American population, 
we all spring from ancestors who came to Amer-
ica—legally or otherwise—seeking opportunity and 
safety not available to them in the land of their birth. 
 
That we individually are many generations removed 
from immigrant status does not excuse the short-
sighted, reactionary view espoused by so many on 
the subject of illegal aliens.  That 9-11 revealed we 
were as vulnerable as the rest of the world to terror-
ist attack does not justify securing our boarders 
against all entrants.  First of all, it is not physically 
possible.  Secondly, the cost of attempting to do so 
would be ruinous. 
 
We would be far better served to remember the con-
tributions made by the Irish and the Germans, and 
the Chinese.  We should ask not what we can do to 
exclude, but rather what can we do to include.  We 
should reflect that most immigrants ultimately be-
come citizens and that their treatment along their 
journey to citizenship helps shape their values, com-
mitment and preparedness to give and sacrifice for 
their new homeland.  As with prior floods of immi-
grants, time heals most of the wounds and slights 
they endured.  But think of the lost opportunities, 
the lost contributions of intellect, labor and entrepre-
neurship that we forego when  first charac-
terize and react to our  immigrant 
neighbors as ‘aliens’ of a legal or illegal 
persuasion.   
 
In recent years, as a nation, we have es-
poused the values of diversity and inclu-
siveness.  Now we need to apply those val-
ues to the current immigration debate. 
 
I look forward to the day when we cele-
brate a Latino Heritage Day in the same 
spirit as St. Patrick’s Day—to that day 
when anyone can be Latino for a day.      
 
Cheers, 
Curt 


